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Preface

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco currently 
supports RSS Version 2.0.

Related Documentation
For more information about the Cisco Smart+Connected Residential products, see the following 
documents and websites: 

Subject / Document Title Location

General

Product Information and Home Page www.cisco.com/go/smartconnectedresidential

Cisco 1-Year Limited Hardware Warranty Terms www.cisco.com/go/smartconnectedresidential
warranty

Regulatory Compliance and Safety Information for Cisco Smart+Connected 
Residential Products

www.cisco.com/go/smartconnectedresidential/
docs

Cisco Support www.cisco.com/cisco/web/support/

Technical Documentaion
v
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Preface
  
Note For information about third-party hardware and software, see the manufacturer’s product documentation 
and/or website.

Release Notes

Cisco Smart+Connected Residential Installation and Configuration Guide

Installation and Configuration

Cisco Smart+Connected Residential Installation and Configuration Guide

Cisco RMS Installation and Administration

Cisco Smart+Connected Remote Management Console Administration 
Guide

Cisco Smart+Connected Remote Management Server Installation Guide

Reference Guides

Cisco Smart+Connected Controller 200 Reference Guide

Cisco Smart+Connected Controller 250 Reference Guide

Cisco Smart+Connected Controller 800 Reference Guide

Cisco Smart+Connected 7” In-wall Display Reference Guide

Cisco Smart+Connected Portable Tablet Reference Guide

Cisco Smart+Connected I/O Extender Reference Guide

Cisco Smart+Connected Universal Remote 150 Reference Guide

Cisco Smart+Connected Universal Remote 250 Reference Guide

Cisco Smart+Connected Video Door Station Reference Guide

www.cisco.com/go/smartconnectedresidential/
docs

Cisco Smart+Connected Residential Licensing and Registration Guide See your Cisco representative or partner for 
more information.

Smart Device Compatibility and other information:

Cisco Smart+Connected Smart Device License for Real Estate Developers

www.cisco.com/go/smartconnectedresidential

 Composer Pro User Guide http://www.control4.com/documentation/Com
poser_Pro_User_Guide/index.htm
vi
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Overview

This document describes how to install and configure the Cisco Smart+Connected Remote Management 
Server. This server is a web application that performs the following functions:

 • Host the Cisco RMS Web Services that are called by Cisco Controllers. 

 • Host the Cisco RMS Console browser-based interface used to manage commissioning and 
diagnostic tests and tasks. 

 • Host the Cisco RMS Locator web service, which directs Cisco Controllers to the correct Cisco RMS 
Server for your deployment. You can direct all Cisco Controllers to a single deployment, or create 
advanced rules to direct specific sets of Controllers to different Cisco RMS Servers, if necessary.

After the Cisco RMS Server and Cisco RMS Locator are installed, use the Cisco RMS Console to 
commission and monitor the Cisco Controllers in your deployment.

Note This document describes how to install the Cisco RMS and Cisco RMS Locator web services on the same 
Windows 2008 server (the server can be a physical or virtual instance). The Cisco RMS installer includes 
the Jakarta Isapi redirector that allows both the Microsoft IIS web server and the Apache Tomcat web 
server to operate without conflict (The Microsoft IIS web server hosts the Cisco RMS Server and 
Management Console, while Tomcat hosts the Locator services). 

Refer to the following topics for more information:

Contents

 • Requirements, page 1-2

 • Summary Steps, page 1-5

 • Obtaining the Cisco RMS Server Software, page 1-6

 • Obtaining and Installing Licenses, page 1-6

 • Install and Configure the Cisco RMS Server, page 2-1

 • Define the Locator Lookup Rules and URLs, page A-1
1-1
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  Requirements
Requirements
Before you begin, verify that the following requirements are met.

Note The installer should be experienced in server and database installation and administration.

Table 1-1 Requirements

Requirements More Information

Requirement 
Complete? 
( )

Network Requirements:

 • One IP addresses for the Cisco RMS 
Server.

 • A DNS entry for the Cisco RMS Server.

 • A DNS-A entry for c4locator that points 
to the Cisco RMS Server.

 • DHCP server with domain suffix 
configured to match yourdomain.com. 

 Prepare the Server and Network Environment, page 2-2

Download and extract the Cisco RMS Server 
software

Obtaining the Cisco RMS Server Software, page 1-6

A SSL certificate signed by Thawte for the 
Cisco RMS Server.

Install and Configure the Cisco RMS Server, page 2-1

http://www.thawte.com

Cisco RMS licenses:

 • One Cisco RMS Server license 

 • One Cisco RMS Client license for each 
Cisco Controller in your deployment

Obtaining and Installing Licenses, page 1-6

A physical server that meets the following 
performance requirements can support up to 
5,000 Cisco Controllers under normal 
operating conditions:

 • Quad-core processor

 • 8GB RAM

 • Server-class disk subsystem (RAID 1 
minimum)

 • An Internet connection (required to 
download and install additional 
third-party software and Windows 
updates.)

See the server documentation for instructions to install the 
physical or virtual machine.

 • The physical server requirements are the minimum 
hardware requirements for each group of 5,000 servers. 
A physical server with additional processor cores, RAM, 
and disk space can support additional Cisco RMS Server 
instances on the same machine.

 • Tasks that require high levels of data transfer can cause 
decreased performance or unreliable operation. For 
example, initial configuration and commissioning of 
large numbers of Cisco Controllers, frequent polling and 
updating, or software update delivery by the Cisco RMS 
Server. To avoid performance or reliability issues, we 
recommend staggering data-intensive tasks, polling 
intervals and software updates. You can also add 
additional Cisco RMS Server instances to support less 
than the maximum number of Cisco Controllers.
1-2
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Operating System: Microsoft Windows Server 
2008 R2 or later (64-bit)

The Windows server can host both the Cisco RMS Server and 
Cisco RMS Locator web applications.

See the following link for additional information: 
www.microsoft.com/windowsserver2008/

Database: Microsoft SQL Server Express Included with the Cisco RMS Server installer. 

The database is used by the Cisco RMS Server. See the 
following for more information:

 • Install and Configure the Cisco RMS Server, page 2-1

 • www.microsoft.com/express/database/

Microsoft Internet Information Services (IIS) 
web server version 7 or later.

The IIS server hosts the Cisco RMS Server web application. 

See the “Install and Configure the Cisco RMS Server” 
section on page 2-1 for more information.

See the following link for additional information: 
http://www.iis.net/

Apache Tomcat and Java Development Kit 
(JDK) 1.6

Included with the Cisco RMS Server installer. 

The Tomcat server hosts the Cisco RMS Locator web 
applications. JDK is required to run the web application.

 • See the “Define the Locator Lookup Rules and URLs” 
section on page A-1 to install and configure the 
software.

 • See the following links for additional information:

 – Tomcat: 
http://tomcat.apache.org (click Tomcat 6 
(http://tomcat.apache.org/download-60.cgi) 
Direct link: 
http://www.oracle.com/technetwork/java/javase/do
wnloads/jdk6-downloads-1637591.html

 – JDK: 
http://www.oracle.com/technetwork/java/javase/do
wnloads/index.html 
(under Java SE 6 Update 33, click the JDK 
Download link)

Table 1-1 Requirements

Requirements More Information

Requirement 
Complete? 
( )
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Microsoft .Net 4.0 Included with the Cisco RMS Server installer. 

Microsoft .Net 4.0 is required to support the web 
applications. 

 • See the “Define the Locator Lookup Rules and URLs” 
section on page A-1 to install and configure the 
software.

 • See the following link for additional information: 
http://www.microsoft.com/net

Microsoft ASP.NET MVC 3 Tools Included with the Cisco RMS Server installer. 

The MVC 3 Tools are required to support the web 
applications. 

 • See the “Define the Locator Lookup Rules and URLs” 
section on page A-1 to install and configure the 
software.

 • See the following link for additional information: 
www.asp.net/mvc/mvc3.

Table 1-1 Requirements

Requirements More Information

Requirement 
Complete? 
( )
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Summary Steps
Complete the following steps to install and configure the Cisco RMS Solution on your network. 

Task Related Documentation

Task 
Complete? 
( )

Step 1 Complete the requirements, including software installation 
downloads, SSL certificates, network requirements, IP addresses 
and other requirements.

Requirements, page 1-2

Step 2 Download and decompress the Cisco RMS Server installation files. Obtaining the Cisco RMS 
Server Software, page 1-6

Step 3 Physically install the server on your existing IP network, or create a 
virtual machine (VM) for the Cisco RMS Server installation.

See your server or VM 
documentation for more 
information

Step 4 Install the Windows Server 2008 on the physical server or VM 
instance.

www.microsoft.com/windowss
erver2008/

Step 5 Revise the network and server properties. Prepare the Server and Network 
Environment, page 2-2

Step 6 Install the Microsoft IIS Web Server. Prepare the Server and Network 
Environment, page 2-2

http://www.iis.net/

Step 7 Install a nd configure the web service software, including the Cisco 
RMS Server and Cisco RMS Locator.

Install and Configure the Cisco 
RMS Web Services, page 2-3

Step 8 Verify the Installation. Verify the Web Service and 
Access the Cisco RMS 
Console, page 2-16

Verify the Cisco RMS Web 
Services Installation, page 2-19

Step 9 (Optional) Deployments with multiple Cisco RMS Servers can 
create Cisco RMS Locator discovery rules for Cisco Controllers.

Appendix A, “Define the 
Locator Lookup Rules and 
URLs”

Step 10 Deploy Cisco Controllers and related equipment using the 
browser-based Cisco RMS Console.

Cisco Smart+Connected 
Remote Management Console 
Administration Guide
1-5
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Obtaining the Cisco RMS Server Software
To obtain the latest Cisco RMS Server software for your release , see the Release Notes for the Cisco 
Smart+Connected Residential Solution.

Obtaining and Installing Licenses
A valid license file with the .lic extension must be installed on each Cisco RMS Server. Each license file 
contains the server and client licenses you must purchase as described in the Release Notes for the Cisco 
Smart+Connected Residential Solution (the license file includes the number of clients supported by the 
server, and the license expiration date).

Obtaining the License File

To obtain the license file, purchase one Cisco RMS Server license and the number of required Cisco 
RMS Client licenses, as described in the following procedure. You will then receive a single license file 
for installation.

See the Release Notes for the Cisco Smart+Connected Residential Solution for more information.

Installing the License File

To install a license file, copy the file to the rms directory on the drive where you installed the Cisco RMS 
data. For example, E:\rms\RMC.lic.

See the Step 4 (select the data partition) and Step 18 (copy the license file to the rms directory) of the 
“Install and Configure the Cisco RMS Server” section for more information.

Procedure

Complete the following procedure to purchase and obtain the Cisco RMS Server license file that includes 
the number of clients required by your deployment.

Step 1 Purchase the license: 

a. Determine the part numbers for the license you want to purchase (see the Release Notes for the Cisco 
Smart+Connected Residential Solution). 

b. Purchase the licences by contacting your Cisco sales representative or Cisco reseller. For more 
information, visit http://www.cisco.com/en/US/ordering/index.shtml.

c. When the purchase is complete, you are issued a Product Authorization Key (PAK) in paper form, 
or in an email message. 

Step 2 Obtain the license file: 

a. Locate the Product Authorization Key (PAK) created with the purchase of the optional feature. 

b. In a Web browser, open the Cisco Product License Registration Web page. 

http://www.cisco.com/go/license/ 

c. Follow the onscreen instructions to complete the form and enter the Product Authorization Key 
(PAK). 

d. Wait for the a license file to be sent to your email address.

e. Transfer the file to the PC or a removable drive that can be accessed during the configuration.
1-6
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Step 3 Install the license file as described in the “Install and Configure the Cisco RMS Server” section on 
page 2-1.
1-7
Cisco Smart+Connected Remote Management Server Installation Guide

OL-27359-02



 

Chapter 1      Overview
  Obtaining and Installing Licenses
1-8
Cisco Smart+Connected Remote Management Server Installation Guide

OL-27359-02



 

Cisco Smart+Connec
OL-27359-02
C H A P T E R 2

Install and Configure the Cisco RMS Server 

The Cisco RMS Server includes a web application that performs two functions:

 • Host the Web Services that are called by the Cisco Controllers. 

 • Host the Cisco RMS Console browser-based interface. 

Complete the following procedures to install and configure Cisco RMS Server and associated web 
services. 

Contents

 • Overview, page 2-1

 • Prepare the Server and Network Environment, page 2-2

 • Install and Configure the Cisco RMS Web Services, page 2-3

 • Verify the Web Service and Access the Cisco RMS Console, page 2-16

 • Verify the Cisco RMS Web Services Installation, page 2-19

Overview
The Cisco RMS Server installation software includes the following software components and settings. 
Complete the “Install and Configure the Cisco RMS Web Services” section on page 2-3 to install the 
software and complete the initial configuration.

 • Cisco RMS Server software (hosted by the Microsoft IIS web server on a Microsoft 2008 server)

 • Microsoft SQL Server Express

 • Microsoft .Net 4.0

 • Microsoft ASP.NET MVC 3 Tools

 • (Locator Installations only) Apache Tomcat, Java Development Kit (JDK) 1.6, and Jakarta Isapi 
redirector.

 • The settings and configurations required to host the Cisco Smart+Connected Remote Management 
Solution.
2-1
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Prepare the Server and Network Environment
Complete the following tasks before installing the Cisco RMS Server software.

Procedure

Step 1 Physically install the server on your existing IP network, or create a virtual machine (VM) for the Cisco 
RMS Server installation.

See the server or VM product documentation for more information.

Step 2 (Optional) Create a user with administrator rights, and using that user to install Cisco RMS (best practice 
is to always create a second user with administrator rights rather than use the default administrator 
account).

Step 3 Change the computer name, description and primary DNS suffix. 

a. Go to Start > Computer > Properties > Change Settings > Computer Name

b. Click Change.

c. Enter a Computer name. For example, RMS_Server.

d. Add the server as a member of a domain, if necessary. For example, cisco.com

e. Click More and enter the Primary DNS Suffix of This Computer to define the Fully Qualified 
Domain Name (FQDN).  
For example, cisco.com

Step 4 Configure the server network properties, such as a static IP address.

Step 5 On the DNS server, add an entry for the Cisco RMS Server. 

We recommend using the default server name rms. For example, rms.<your_domain>.com

Step 6 (Optional but recommended) Create a data partition where the Cisco RMS web services files will be 
installed.

 • For example, open the Disk Management utility and create a new volume (Figure 2-1). 

 • You may need to shrink the size of the C: volume to free up space for the new partition. 

 • Assign the volume a drive letter, such as E: and assign a meaningful name such as rms_data.

 • We recommend creating an 8 GB partition in the NTFS format. 
2-2
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Figure 2-1 Creating a Data Partition for the Cisco RMS Files

Install and Configure the Cisco RMS Web Services
Procedure

Step 1 Complete the network, server and other requirements necessary to install and operate the Cisco 
Smart+Connected Remote Management Solution. See the following for more information:

 • Requirements, page 1-2

 • Prepare the Server and Network Environment, page 2-2

Step 2 Download and extract the .zip rms installer package.

 • See the “Obtaining the Cisco RMS Server Software” section on page 1-6 for more information.

 • See the “Overview” section on page 2-1 for a summary of the software components included in the 
installer archive.

 • The files are extracted to the /rms_install directory on your local drive (Figure 2-2).
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  Install and Configure the Cisco RMS Web Services
Figure 2-2 Installer Directory and .bat (Batch) File

Step 3 Launch the rms_setup.bat installer file located in the /rms_install directory (Figure 2-2).

Step 4 In the terminal window, enter the initial prompts (Figure 2-3):

a. Enter the drive where the installer files will be stored. For example: E:

b. Enter Y to install the Cisco RMS Locator service.

Note We recommend installing the Cisco RMS Locator service Each a Cisco RMS client (Controller) 
cannot access a Locator, then the Controller will attempt to access rms.<yourdomain>.com.
2-4
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  Install and Configure the Cisco RMS Web Services
Figure 2-3 Initial Installer Prompts

Step 5 Wait for the various installation tasks to complete (Figure 2-4). For example:

a. The directory structure is created. 

b. Cisco RMS resources such as tests, tasks, themes, project backup and other features are installed 
and configured. 

c. The .NET 4.0 Framework is installed. 

d. The Microsoft ASP.NET MVC 3 Tools are installed.

e. Other required software and configurations are installed and implemented.

Figure 2-4 Installation Window Samples
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  Install and Configure the Cisco RMS Web Services
Step 6 Wait for the ASP.Net configuration to complete (Figure 2-5). 

Figure 2-5 ASP.NET Installation

Step 7 Wait for the additional configurations to be applied in the CLI (Figure 2-6).

 • For example, the IIS Web Server Role is installed.

 • The “Default Web Site” is also deleted and replaced by an “RMS” website (and the new RMS 
website is started).

Figure 2-6 IIS Web Server Installation
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Chapter 2      Install and Configure the Cisco RMS Server
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Step 8 Wait for the Microsoft SQL Server Express installation and configuration to complete (Figure 2-7). 

 • This process also configures the SQL server for use with Cisco RMS (for example, the database is 
created, the schema is applied, the tables and other settings are also created.

Figure 2-7 SQL Express Installation

Step 9 (Locator installations only) Follow the on-screen instructions to install the Java Development Kit (JDK). 
(Figure 2-8).

 • Click Next or Close when prompted to complete the installation.

 • Close the Java registration site if it appears.

Figure 2-8 Java (JDK) Installation
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  Install and Configure the Cisco RMS Web Services
Step 10 Wait for the installation to complete (Figure 2-9).

 • For example, the Registry values for the ISAPI redirector are created if you are installing the Cisco 
RMS Locator.

Figure 2-9 Final Installation Settings

Step 11 (Locator installations only) Click Start in the Apache Tomcat 7.0 Tomcat7 Properties window 
(Figure 2-10) to start the Tomcat web server. 

Note Be sure the startup type is set to Automatic (Figure 2-10).

Figure 2-10 Apache Tomcat Properties

Step 12 Restart the Windows 2008 server (Start > Restart) to restart the IIS and Tomcat web servers.

Step 13 Log in to the Administrator account on the Windows 2008 server.

Step 14 When the Initial Configuration Tasks window appears (Figure 2-11), verify that the Web Server (IIS) role 
appears. This indicates that the web server was successfully installed.
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  Install and Configure the Cisco RMS Web Services
Figure 2-11 IIS Web Server Role

Step 15 Create the security certificate.

Note Production Cisco RMS Servers communicate using a secure, encrypted HTTPS connection that is 
enabled by a certificate from a recognized Certificate Authority (such as Thawte). Self-signed 
certificates are not secure and are useful only for verifying the web site configuration. Cisco Controllers 
will not sync with an RMS server that is using a self-signed certificate.

a. Open the Internet Information Services (IIS) Manager (Start > Administrative Tools > Internet 
Information Services (IIS) Manager).

b. In Connections, select the root server (Figure 2-12). 
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Figure 2-12 IIS Manager Server Certificates

c. Double-click the Server Certificates icon (Figure 2-12) in the middle pane to display the Server 
Certificates window.

d. Select Create Certificate Request (right pane) to request a new certificate from a recognized 
Certificate Authority (Figure 2-12). 
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Figure 2-13 Create Certificate Request

e. Complete the form to request a new certificate from a recognized Certificate Authority (such as 
Thawte). 

f. Submit the certificate request code on the Certificate Authority website. 

g. You will receive a certificate code from the Certificate Authority. Paste the certificate code into a 
file and save on your drive. 

h. Click Complete Certificate Request to upload the certificate you receive from the Certificate 
Authority.

Note See the Microsoft and Thawte documentation for more information. 

Step 16 Add the HTTPS binding and add the certificate.

a. Select the RMS web site (for example Sites > rms) from the left pane (Figure 2-14).

b. Click Bindings (right pane under Actions tab). 

c. Click Add in the Site Bindings window.
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Figure 2-14 Add Site Bindings

d. Select the following in the Add Site Bindings window (Figure 2-15):

Figure 2-15 Add Site Bindings

 – Type—https 

 – IP Address—All Unassigned

 – Port—443

 – SSL certificate—Select the SSL certificate you created in Step 15.

Step 17 Import the certificate file that allows Cisco Controllers to connect to the RMS server.

To do this, import the installation file clientca.pem to the server’s Trusted Root Certification Authorities. 
The clientca.pem is in the Resources directory of the extracted Cisco RMS installation files. 

a. Select Start > Run > mmc to launch the MCC.

b. Select File > Add/Remove Snap-in...

c. Double-click Certificates (under Available Snap-ins) and click OK. 
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You can also select Certificates and click Add.

d. Select My user account (In the dialog This snap in will always manage certificates for) and click 
Finish.

e. Expand CERTIFICATES > TRUSTED ROOT CERTIFICATION AUTHORITIES and select 
the Certificates folder (Figure 2-16). 

The current list of certificate authorities on the server is displayed (Figure 2-16). 

Figure 2-16 Trusted Root Certification Authorities

f. Right-click the center pane and select All Tasks > Import. 

g. A wizard will appear. 

h. Using the Certificate Import Wizard, click Next and Browse to select the clientca.pem file (located 
in the \Resources directory of the extracted Cisco RMS installation files). See Figure 2-17.

Tip Select the All Files (*.*) file type to display the .pem file (Figure 2-17). 
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Figure 2-17 Select the .PEM File

i. Click Open and then Next.

j. Select Place all certificates in the following store and verify that Trusted Root Certification 
Authorities appears in certificate store (Figure 2-18). 

Figure 2-18 Certificate Store

k. Click Next.

l. Click Finish to complete the certificate import wizard.

m. Click Yes to accept any security warnings and install the certificate.

n. Click OK when the import process is successful.
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o. Exit the console and click No when asked to save the Console settings.

Step 18 Install the .lic Cisco RMS license file.

The license file enables a single Cisco RMS Server and the number of clients purchased as client 
licenses. See the “Obtaining and Installing Licenses” section on page 1-6 for more information.

a. Navigate to the location where the .lic license file is stored. For example, a USB flash drive. See 
the Step 2 (extract the installation files) for more information.

b. Copy the RMC.lic file to the rms directory on the drive where you installed the Cisco RMS data. 
For example E:\rms\. See the Step 4 (select the data partition) for more information.

Step 19 (Locator installations only) Define the default Cisco RMS Server that Cisco Controllers will use by 
default.

Cisco Controllers will be redirected to the specified Cisco RMS Server by the Cisco RMS Locator 
service. To create advanced rules for deployments that include multiple Cisco RMS Servers, see 
Appendix A, “Define the Locator Lookup Rules and URLs.”

a. Navigate to the C:\control4\ems directory (Figure 2-19).

Figure 2-19 Cisco RMS Locator.xml Configuration File

b. Open the locator.xml file using a text or XML editor such as Notepad++ (Figure 2-20).

c. Replace the default IP address or hostname with the IP address or hostname for your Cisco RMS 
Server:

The Cisco RMS hostname is the computer name defined in Step 3 of the “Prepare the Server 
and Network Environment” section on page 2-2.

For example, change 

rms.control4.com:8080/rms-service/rmsService

to

rmstest.yourdomain.com/RMEngineServices/RMService.asmx 

See Figure 2-20.
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Figure 2-20 Cisco RMS Locator Configuration Files

Step 20 Verify the installation as described in the following topics:

 • Verify the Web Service and Access the Cisco RMS Console, page 2-16

 • Verify the Cisco RMS Web Services Installation, page 2-19

Verify the Web Service and Access the Cisco RMS Console
Complete the following procedure to verify that the web services are accessible and that you can log on 
to the Cisco RMS Console.

Tip If you are unable to access the we services or management console, refer to the “Verify the Cisco 
RMS Web Services Installation” section on page 2-19 to verify that the web server files and 
settings were installed correctly.

Procedure

Step 1 Enter localhost (or the Cisco RMS Server IP address) to verify web server connectivity (Figure 2-21). 

Note You may experience a delay the first time you connect while Cisco RMS tests and tasks (and 
other files) are added to the system. 

For example, enter one of the following URLs in a web browser to verify connectivity:

 • If connecting from the local machine, enter localhost and wait for the web page to redirect to the 
https site: 
https://localhost/locator-service

 • If connecting from a different machine:  
https://<IP Address>/locator-service 

Note The page will redirect to the secure https site if you enter the non-secure “http”.
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Step 2 Log in to the Cisco RMS Console (Figure 2-21):

The default credentials are:

 • Username—admin@control4.com

 • Password—p@ssw0rd

Figure 2-21 Cisco RMS Console Login Page

Note The “https” will be displayed in red with a line through it if you installed a self signed certificate 
for testing. Self signed certificates are not secure and do not support Controller connections.

Step 3 Select Configuration > Tests and Configuration > Tasks to verify that the default set of tests and tasks 
were successfully created (Figure 2-22).

Figure 2-22 Cisco RMS Console Tests and Tasks

Step 4 Verify that the Cisco RMS Locator service is available (Figure 2-23).

a. Enter the Cisco RMS Server URL:

https://localhost/locator-service

b. Verify that the AdministrationService and LocatorService appears in the Available SOAP services 
web page.
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Figure 2-23 Cisco RMS Locator Service

Step 5 Verify that the Cisco RMS engine services are available (Figure 2-24).

a. Enter the Cisco RMS Server URL:

https://localhost/RMEngineServices

b. Verify that the RMService.asmx file is present.

Figure 2-24 Cisco RMS Engine Service
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Verify the Cisco RMS Web Services Installation
If you are unable to access the web services or management console, complete the following procedure 
to verify that the web server files and configurations were successfully installed.

Procedure

Step 1 Verify that the Tomcat files are installed correctly.

a. Open the Windows file explorer and navigate to the C:\tomcat7\cong directory.

b. Verify that the uriworkermap.properties and workers.properties.minimal are present 
(Figure 2-25).

Figure 2-25 Tomcat Configuration Files

c. Navigate to the C:\tomcat7\bin directory and verify that the isapiredirect.dll file is present. 
(Figure 2-26).

Figure 2-26 Tomcat bin Files
2-19
Cisco Smart+Connected Remote Management Server Installation Guide

OL-27359-02



 

Chapter 2      Install and Configure the Cisco RMS Server
  Verify the Cisco RMS Web Services Installation
Step 2 Verify that the RMS web configuration file is properly installed.

a. Open the C:\rms_web\web.config file in a text editor such as Notepad++.

b. Scroll down to the <appSettings> section and verify that no entries include the “%” placeholder 
symbol (Figure 2-27).

Figure 2-27 Website Configuration File
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Step 3 Verify that the Web Site directories and files are properly installed in the hard disk data partition you 
created in Step 6.

a. For example, navigate to E:\rms-data.

b. Verify that it includes the data directories similar to those displayed in Figure 2-28.

Figure 2-28 RMS Data Directories

Step 4 Verify that the Cisco RMS Locator files are installed at C:\control4\ems (Figure 2-29).

Figure 2-29 Cisco RMS Locator Configuration Files

Note A link to the C:\control4 directory is also added to the administrator account home directory. 
This link ensures proper operation of the Locator web service in the IIS web server environment.
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Step 5 Verify that the Jakarta Isapi redirector was successfully installed.

a. Launch Internet Information Services (IIS) Manager (Start > Administrative Tools > Internet 
Information Services (IIS) Manager).

b. In the Connections page, select the rms site.

c. Verify that the jakarta virtual directory is present.

d. In the middle pane, verify that the ISAPIFilters icon is present. (Figure 2-30). 

Figure 2-30 Jakarta ISAPI Filters

Step 6 Verify that the Jakarta Isapi redirector was successfully added to the Windows registry.

a. Select Start > Run and enter regedit to verify that the Isapi redirector registration entries were 
added.

b. Verify that the following directory is present (Figure 2-31):

HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Jakarta Isapi 
Redirector\1.0
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Figure 2-31 Jakarta Isapi Redirector Registry Entries
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Define the Locator Lookup Rules and URLs

The purpose of the Locator service is to automatically redirect Cisco Controllers to a Cisco RMS Server 
based on the Controller properties and a set of Locator lookup rules. This section defines the Locator 
lookup rules that can be entered in the locator.xml file.

Refer to the following topics for more information:

 • Locating the Locator, page A-1

 • XML Rule Criteria, page A-6

 • Rule Based Lookup, page A-2

 • XML Syntax, page A-2

 • Proxy, page A-3

 • Logical Operators, page A-4

 •  URLs, page A-4

 • No Match, page A-5

 • Device Specific DB Lookup, page A-6

 • XML Rule Criteria, page A-6

Locating the Locator
The Locator is discovered by the Cisco Controllers using a manually entered DNS-A record.  See the 
“Requirements” section on page 1-2.

Configure the Location of the locator.xml File
After installation there should be a configuration file in: 

<user home>/control4/ems/locatorservice-config.properties

In this file there is a property locator.rules.path that should be set to the path of the locator.xml file 
that includes the lookup rules. For example:

Unix example:

locator.rules.path=/Users/rms/control4/ems/locator.xml

Windows example:
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locator.rules.path=C:\\rms\\control4\\ems\\locator.xml

If the location of the rules, or the rules themselves have changed the Locator service needs to be 
restarted.

Rule Based Lookup
The primary lookup mechanism is a list of rules that determines what location should be returned.

The input to the Locator is a set of optional parameters where each has a name and a value. A few 
examples are Service name, Device IP address, Common Name and Domain.

The output from the Locator contains a URL. 

The first lookup criteria is what service is requested. If the Service Name is for example RMS the device 
is looking for the RMS service.

Once the requested service is determined a list of rules for this service are applied in order to find a match 
for the submitted parameters. The first successful match will be used and the resulting URL is 
assembled.

Here is a simple high level example of rules:

Service: RMS

1. IP address range: 10.10.X.X => http://rms1.mydomain.com/rms-service 

2. IP address range: 10.20.X.X => http://rms2.mydomain.com/rms-service

Default => http://defaultrms.control4.com/rms-service  

No services match  => http://defaultlocator.control4.com/locator-service (PROXY)

If a device requests the RMS service and has the IP address 10.10.0.1 it will match the first rule and the 
Locator will return the URL http://rms1.mydomain.com/rms-service. If the device instead had the IP 
address 10.20.250.200 it would match the second rule and get the URL 
http://rms2.mydomain.com/rms-service back. The default http://defaultrms.control4.com/rms-service is 
returned if there was no other rule match for the requested RMS service. If the ACCOUNT service was 
requested it would return http://defaultlocator.control4.com/locator-service, and in this case it is another 
Locator, a proxy.

XML Syntax
The rules are expressed in XML and the example above could have the following syntax:

<services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="http://defaultrms.control4.com/rms-service" 

type="url">
<rule name="RMS1" host="rms1.mydomain.com" path="/rms-service">

<ip match="10.10.0.0/16" />
</rule>
<rule name="RMS2" host="rms2.mydomain.com"  path="/rms-service">

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

The /16 in the IP address match means that the rule will try to match the first 16 bits in the IP address.
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The URL components are inherited from higher up in the tree, so another way to express the same rules 
are as follows:

<services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="http://defaultrms.control4.com/rms-service" 

type="url">
<rule name="RMS1" host="rms1.mydomain.com" >

<ip match="10.10.0.0/16" />
</rule>
<rule name="RMS2" host="rms2.mydomain.com" >

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

Input Parameters

Locator responseService IP address

RMS 10.10.40.50 http://rms1.mydomain.com/rms-service 

RMS 10.20.40.50 http://rms2.mydomain.com/rms-service 

RMS 99.01.40.50 http://defaultrms.control4.com/rms-service 

Proxy
The result URL returned from the lookup has a type associated with it. The type can be URL or PROXY. 
PROXY typically means that it points to another Locator.

<services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="http://defaultrms.mydomain.com/rms-service" 

type="url">
<rule name="RMS1" >

<ip match="10.10.0.0/16" />
</rule>
<rule name="RMS2" host="rms.mydomain.com" >

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

Input Parameters

Locator responseService IP address

ACCT 30.10.40.50 http://defaultlocator.control4.com/locator-service (PROXY)

RMS 30.10.40.50 http://defaultrms.mydomain.com/rms-service (URL)

RMS 10.20.40.50 http://rms.mydomain.com/rms-service (URL)
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Logical Operators
Logical “and” and “or” can be used in the rules for more flexibility. They can be nested in the tree. For 
example here is a set of rules that uses both to match two separate IP ranges and a portion of the common 
name:

<services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="http://rms1.mydomain.com/rms-service" type="url">

<rule name="RMS1" >
<and>

<or>
<ip match="10.10.0.0/16" />

<ip match="10.20.40.0/24" />
</or>
<commonName match="MyCommonName[0-9]+" >
</and>

</rule>
<rule name="RMS2" host="rms2.mydomain.com" >

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

The commonName match is using a regular expression to match common names that starts with 
“MyCommonName” followed by one or more numbers. 

Input Parameters

Locator responseService IP address Common Name

RMS 10.10.40.50 MyCommonName123123 http://rms1.mydomain.com/rms-service 

RMS 10.20.40.50 MyCommonName123123 http://rms1.mydomain.com/rms-service 

RMS 10.20.40.50 MyOtherName123123 http://rms2.mydomain.com/rms-service 

 URLs
The services node and the service nodes have a mandatory defaulturl and type.

defaulturl=https://rms1.mydomain.com/rms-service  type="url"

The services defaulturl is used when there is no service matching the given service name.

The service defaulturl is used when none of the rules for that service are matching. 

Each rule may define any URL components protocol, host, port, path or type which will override what 
is in the defaulturl. If they are not overridden the defaults will be inherited and used.

For example:

<services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="https://rms1.mydomain.com/rms-service" 

type="url">
<rule name="RMS1" port="8888" >

<and>
<or>

<ip match="10.10.0.0/16" />
<ip match="10.30.40.0/24" />
</or>
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<commonName match="MyCommonName[0-9]+" >
</and>

</rule>
<rule name="RMS2" port="9999" host="rms2.mydomain.com" >

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

Note that URL components are inherited so they don’t have to be specified for each rule. In the example 
the first rule specifies port 8888. If this rule would match, the port would be 8888 and the other URL 
components would come from the defaulturl: https://rms1.mydomain.com:8888/rms-service 

Input Parameters

Locator responseService IP address Common Name

RMS 10.30.40.50 MyCommonName123123 https://rms1.mydomain.com:8888/rms-service 

RMS 10.20.40.50 MyCommonName123123 https://rms2.mydomain.com:9999/rms-service 

No Match
If there is no match for even the service name the services defaulturl will be used. This services default 
typically should point to another Locator.

If the service name matches but there is no match for any rules in that service, the service defaulturl 
will be used. 

 <services defaulturl="http://defaultlocator.control4.com/locator-service" type="proxy" >
<service match="RMS" defaulturl="https://defaultrms.mydomain.com/rms-service" 

type="url">
<rule name="RMS1" port="8888" >

<and>
<or>

<ip match="10.10.0.0/16" />
<ip match="10.30.40.0/24" />
</or>
<commonName match="MyCommonName[0-9]+" >
</and>

</rule>
<rule name="RMS2" port="9999" host="rms2.mydomain.com" >

<ip match="10.20.0.0/16" />
</rule>

</service>
</services>

Input Parameters

Locator responseService IP address

RMS 11.30.40.50 https://defaultrms.mydomain.com/rms-service 

Other 10.20.40.50 http://defaultlocator.control4.com/locator-service (PROXY)
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Device Specific DB Lookup
If common name and service name is submitted from the device a database lookup will be attempted 
before trying to match any rule. If the particular device common name is in the database for that service, 
the particular service URL mapped to that common name will be returned. This feature requires that the 
Locator database is pre populated with common name to service URL mappings.

XML Rule Criteria
The currently supported set of XML rule criteria are shown in the following table:

XML criteria name Description Match type

commonName Common name Regular expression

macAddress Device mac address Regular expression

primaryDns Primary DNS IP address IP address match using CIDR bit mask

defaultGateway Default Gateway IP address match using CIDR bit mask

ip Device IP address IP address match using CIDR bit mask

domain Domain Regular expression

dhcpMacAddress DHCP server MAC address Regular expression

secondaryDns Secondary DNS IP address IP address match using CIDR bit mask

userAgent User-Agent HTTP Header Regular expression
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